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1 INTRODUCTION

This guide introduces the features that our plugin provides for Scratchbox development, and
describes how to apply them. The Scratchbox development tool is plugin Laika that is based
on the C/C++ development tools (CDT) (http://www.eclipse.org/cdt/) plugin for Eclipse. Our
aim is to reuse and extend their features to provide the possibility to build, run and debug
C/C++ programs inside Scratchbox using the Eclipse IDE. In the plugin there are connected
methods that help using Maemo (http://www.maemo.org) via Eclipse. The main difficulty so
far in development has been the lack of developer documentation of the CDT project.
Therefore, the development work has been based solely on the CDT source code.

1.1 In Brief

All the chapters described briefly.

1.1.1 Chapter I: Introduction

This chapter gives a first-hand information about the Laika plugin and how to use it.

1.1.2 Chapter Il: Requirements

All the needed programs and addings are specified here. Requirements include links /
adresses to the required programs web-pages.

1.1.3 Chapter lll: Installation

Installation chapter specifies, what has to be done before running Laika for the first time.
When installing new templates to Laika plugin, user should use Add new template to Laika
plugin method in Scratchbox toolbar icon.

1.1.4 Chapter IV: Using the Plugin

Using the plugin is by far the largest chapter in this guide. It tells how to use the plugin
properly. All the settings are explained briefly. The creation of project is detailed very
carefully. The guide explains differences between project types, the selections available in
current project and how to modify the project. The usage of compile, run, debug and the
differences from CDT are all introduced in their own sections. The main difference between
typical C/C++ project and Scratchbox project is the target, where the project will be built.
For example ARM target creates an ARM binary and X86 target creates a X86 binary,
whereas the typical C/C+ creates always the binary corresponding the processor where the
binary is built. The next section of using the plugin is about creating Debian packages. The
section introduces the use of creating rules for creating Debian package and how to create
them. Also tips for installing Debian packages to Nokia 770 are located in the end of this
chapter.
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1.1.5 Chapter V: Behid the Scenes

This chapter describes the features, that need to be detailed more specific. Most of this
chapter includes information about how automake is used in our plugin.

1.1.6 Chapter VI: Known Issues

Known issues chapter is all about the problems we have encountered during the creation of
Laika plugin. It has issues from environment, software, real device and general category.

1.1.7 Chapter VIl: References

This chapter includes the references.

1.2 Declarations

1.2.1 Autogen

Autogen is a script, which we use in automake projects. It will execute the following scripts,
so user does not need to pay attention to these: aclocal, autoconf, automake and configure.

1.2.2 Bourne Shell

Steve Bourne, wrote the Bourne shell which appeared in the Seventh Edition Bell Labs
Research version of Unix. Other shells include the Korn Shell (ksh), the C Shell (csh), and
variations such as tcsh.

1.2.3 CDT

The CDT (C/C++ Development Tools) Project is working towards providing a fully
functional C and C++ Integrated Development Environment (IDE) for the Eclipse platform.

1.2.4 CPU-Transparency

A feature of the Scratchbox where a programs and scripts can run their cross-compiled
installation or build environment test binaries like they were native. Scratchbox has told the
desktop kernel to run foreign binaries with one of the cpu transparency methods. All this is
transparent to the software which thinks it's doing native compilation when it's actually
cross-compiling software on a much faster x86 machine.

Currently there are two supported cpu tranparency methods in Scratchbox : QEMU and
SBRSH.
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1.2.5 GDB Server

GDBServer is a control program for Unix-like systems, which allows you to connect your
program with a remote GDB via target -remote, but without linking in the usual debugging
stub.

1.2.6 GTK

GTK+ is a multi-platform toolkit for creating graphical user interfaces. Offering a complete
set of widgets, GTK+ is suitable for projects ranging from small one-off projects to
complete application suites.

1.2.7 Hildon

Hildon is a set of graphical libraries, that are built inside GTK. Hildon is actually a user
interface framework, which is on use in Nokia 770 Portable Internet Tablet.

1.2.8 Maemo

Maemo is composed of popular open source software components which are widely
deployed in the leading Linux desktop distributions today. Maemo adapts these components
to the handheld environment and contributes new technology like easy tools for non-x86
development, Hildon user interface framework, and some useful applications for Hildon.

Maemo rootstrap is Maemo environment under Scratchbox.

1.2.9 QEMU-ARM

QEMU is a generic and open source processor emulator which achieves a good emulation
speed by using dynamic translation. QEMU-ARM is ARM emulator which based on
QEMU. That is also Scratchbox target's CPU-transparency method.

1.2.10 SBRSH

Scratchbox Remote Shell is an rsh/ssh-like utility for Linux that supports terminal
emulation, automated mounting of network shares, chroot, etc. Foreign binaries are run by
'sbrsh' client which will tell a 'sbrshd' daemon on an ARM device in the network to NFS
mount relevant directories from the Scratchbox (desktop machine), execute the binary and
redirect all the I/O back to the desktop machine. SBRSH is also Scratchbox target's CPU-
transparency method.

1.2.11 Scratchbox

Scratchbox is a cross-compilation toolkit designed to make embedded Linux application
development easier. It also provides a full set of tools to integrate and cross-compile an
entire Linux distribution.
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2 REQUIREMENTS

To use our plugin, the user needs the Eclipse IDE and the C/C++ Development Tools plug-
ins in addition to the Scratchbox environment. Also, the underlying operating system needs
to have the Bourne Shell available at “/bin/sh”. This is because of the mechanism that is
used to run the commands inside the Scratchbox (using the “login” script). The tested and
thus supported versions are as follows, and there is also a brief installation tutorial. These
versions are recommendations, but Eclipse needs to hava a working CDT, so don't use
Eclipse versions under 3.0. Also using Scratchbox versions under 0.9.8.5 are not
recommended, since they are not tested.

Eclipse v.3.1

® Download and extract Eclipse package:
http://www.eclipse.org/downloads/

® Remember that Eclipse requires Java virtual machine

® We are using Java(TM) 2 Runtime Environment, Standard Edition 1.4.2_08
CDT v.3.0

® Please note that there are separate update sites for the 2.x versions of the CDT and
the 1.x versions. The reason for keeping them separate is because the CDT 1.x series
will NOT run on Eclipse 3.x, and the CDT 3.0 series MUST run on Eclipse 3.1.

® Eclipse plugin, which allows you to generate C/C++ code with Eclipse

® Download and extract CDT package:
http://www.eclipse.org/cdt/

Scratchbox v.0.9.8.5 (or 1.0.1, not supported by Maemo)

® Download and install Scratchbox packages:
http://www.scratchbox.org/download/files/sbox-releases/0.9.8/

® The Debian packages can be installed from this APT source:
deb http://scratchbox.org/download/files/sbox-releases/0.9.8/deb/ ./

® More information about installation of Scratchbox:
http://scratchbox.org/documentation/docbook/0.9.8/installdoc.html

Maemo v.1.1 (or v1.0)

® Download Maemo rootstrap packages for ARM and 1386:
http://maemo.org/downloads/download-sdk.html

® Put packages into /scratchbox/packages directory
® Create new target into Scratchbox and install Maemo rootstrap there

® More information about using Maemo:
http://maemo.org/platform/docs/tutorials/Maemo tutorial.html
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3 INSTALLATION

The plugin should be installed by unpacking the files inside the user’s eclipse IDE root
directory. This is often the directory “~/eclipse”. They will be unpacked under the “plug-ins”
directory, and Eclipse will find them there the next time it is run. The latest version of Laika
plugin can be downloaded from our web site at:

http://kooditakomo.cs.tut.fi/projects/laika/ or

http://www.cs.tut.fi/~laika/downloads.shtml

After installing all necessary programs mentioned in previous chapter (2. References), user
will have to create a user and target to Scratchbox, before using Laika plugin. Instructions
are found at http://www.scratchbox.org/documentation/docbook/0.9.8/installdoc.html

chapters 2.3 & 2.4.

Before creating first Scratchbox project with Laika, Scratchbox version and other
perferences must be set from preferences page (detailed in 4.1).

When installing new templates to Laika plugin, user should use Add new template to Laika
plugin method in Scratchbox toolbar icon. More details in section 4.9.1 Adding own
templates.
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4 USING THE PLUGIN

4.1 Setting preferences

The first thing a user should do is to set the preferences for using Scratchbox, since the rest
of the functionality of the plug-ins depends on these settings. Once the Eclipse IDE is
running with the plug-ins, the preferences may be set via the “Window->Preferences” menu,
under which there is a list with the option “Scratchbox Preferences”.

rpe filter text | = Scratchbox Preferences =R

b General General Syntaxes for Scratchbox:
b ARt _
Wersion of default preference wvalues: |Scratchbox 0.9.8.pref =

I CfC++ =
b Help Sandbox Root Directory: |jscratchboﬁusersfreijula Browse...
b Install/Update Invoking Scratchbox commands: |fscratchboxf|ogin -d ${directory} ${command} ${args}
I Java
b Plug-in Developme: Listing build targets: |sbox-conﬁg -It
b Run/Debug The syntax for choosing a build target: |sb0x-config -st ${target}
> Starting GDB server inside Scratchbox: |qemu-arm -g ${binary}

Build Target

K-Environment
[ Team
| Restore Defaults Apply
4 — 3

oK Cancel

Figure 1. The Scratchbox preferences page

The Scratchbox preference page offers the user a way to define the syntax used to invoke
commands inside Scratchbox (this varies between versions), the root directory of the user’s
sandbox environment, and the target that is chosen for building and running programs. Note
that to be able to change the target, the user shouldn’t have open Scratchbox sessions
running. The list of targets is parsed at run-time utilizing the command that is configured in
the text field titled “Listing build targets”. For Scratchbox 1.0.1, this would be “sb-conf list —
targets”, and for Scratchbox 0.9.8.5, “sbox-config -It’. Scratchbox documentation provides
information on initially setting up the build targets.

When the build target has been selected and the preferences have been accepted, the target
will be chosen using the syntax that Scratchbox provides. For Scratchbox 1.0.1 it would be
“sb-config select ${target}” and for Scratchbox 0.9.8.5 “sbox-config —st ${target}”,
respectively.

GDB server field contains a command which will start debugging program with GDB
server inside scratchbox if checkbox is selected from debugger tab. In 0.9.8.5 Scratchbox
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4.2

command is "gemu-arm -g ${binary}” when using ARM target and QEMU-ARM as CPU-
transparency method. When using SBRSH, the command could be example ”gdbserver
localhost: 10000 ${binary}”

User can import his own made preference files. This can be useful when having a different
preferences from default settings. These files are located in preferences directory under
Laika core plugin. The plugin only accepts files with .pref extension. When using Laika for
the first time, changing preference file or after importing user own perference file it is
required to close and reopen the preferences dialog to update the dialog and settings.

PR . (ol et Aahdl fpe fiter text. = X-Environment ERCE
b Genera |
B b General
b Ant T ) BN T Preferences for Running Graphical Programs inside Scratchbox:
Select The Build Target b Art
b oCicH+ The syntax for starting X-server: [xune 11 -geometry 800480 -depth 16
b el ® HosT Details b CjCH+
=P b Help [ Run X-server command inside scratchbox
b InstallUpdate O ARM Details
b Java b InstallUpdate The syntax for starting viewer: [wneviewer 127.00.1:1
b Plug-in Developmer b Java The syntax exporting display's IP and number: ‘D\SPU-\V:IU 0.0.1:1
b Run/Debug b Plug-in Developmer
~ Scratchbox prefere b Run/Debug
7 Scratchbox Prefere
¥-Environment Build Target
b Tearn
b Team
B i e o= ol e o
oK Cancel oK Cancel

Figure 2a,b. Preference page for selecting Scratchbox target and X-environment

Second subpage shows available targets and lets user to select the current build target. User
can also check target details when clicking details button.

The last subpage contains commands for the starting X-environment and exporting display
for Scratchbox applications. Default settings are made for Xvnc. If your viewer program
does not have server and viewer separated just leave the server or viewer textfield empty.
When Run X-server command inside Scratcbox is selected the command for starting X
server is runned inside the sandbox. Otherwise the command is runned locally.

NOTE: When using target where SBRSH has been selected as CPU-transparency method
leave field "The syntax exporting display's IP and numer” empty.

Creating a project

The “Standard Make C/C++ Project inside Scratchbox” should be used when creating a
normal C program with for example GTK+ libraries. The “Automake Hildon Project inside
Scratchbox” should be used when creating a Hildon applications. After selecting which
project user wishes to create, all he has to do is follow the wizard. The couple first pages are
similar in both wizards.

4.2.1 Overview

The user may create a Scratchbox project largely in the same manner as a standard C/C++
project. This may be done via the menu options “File->New->Project” or by clicking on the
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shortcut icon on the top left corner of the screen. The user may choose either a “Standard
Make C/C++ Project inside Scratchbox” or the “Automake Hildon Project inside
Scratchbox”. The CDT help functionality in Eclipse provides more information on the
differences of the standard and the managed make project types. If the user does not want to
start from the beginning every time he creates a new project, he can create his own template
and add it to New Project Wizard or use one of the ready templates.

& New Project X

C++/Make Scratchbox Project Settings

Cefine the project and Scratchbox 'make' builder settings

Make builder settings.

=*Projects erf Error Parsers | Binary Parser | C/C4++ Indexer
Build command
v Use default

Build command:

Build Setting
Stop on first build error,

‘Workbench Build Behavior

Workbench build type: Make build target:
Build on resource save (Auto Build)

MNote: See Workbench automatic build preference.

v Build (Incremental Build) all
v Rebuild (Full Build) clean all
v Clean clean
4 o
< Back Next = Einish Cancel

Figure 3. Settings for a new project

After proceeding by clicking on the “Next” button, the user may enter the project location.
The default location is constructed on the basis of the Scratchbox root directory that was
entered in the preferences. The wizard will not allow a project to be set outside this
directory, since then it would be impossible to access it from within Scratchbox.

The following pages provide the same options that are available for a standard C/C++
project. The user may change e.g. the commands used for different kinds of builds, as well
as select the error parsers and binary parsers that should be used.

To modify the settings that are used for building, the user may use project property pages.
Their use is described in the following section (section 4.3).
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4.2.2 Automake Hildon Project inside Scratchbox

In Automake Hildon projects user will be able to create empty project, which will create a
empty structure (but lots of files). Just click Finish and empty project will be created. User
will not need to make makefiles himself and his application can easily be compiled and
made for Nokia 770 Application installer.

7 New Project X
Customized Hildon template
Create your own Hildon application
_Msnu *  add Title

Clear all

Figure 4. Wizard for selecting custom addings

A user of Laika can also customize his projects. He can edit title, create modifiable menu
and toolbar. Title page in wizard allows user to create a two part title for program. With
menu page user can create a menu with submenus, normal menuitems, separators, radio-,
and checkbuttons. Toolbar page allows user to create different kind of buttons, separators
and comboboxes.
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Y 2 =Y %

Custom menu page

Add menu for your application

Set a new title for your menu view My Menu
"add item

Clear All

Submenul (mainmenu)
Radiol (Submenul)
Checkl {Submenu1)

Enter name to your item: line
Select type: Separator
Add submenu to this parent: |mainmenu

Avoid using other than default characters (a-z)

OK Cancel

Avoid using other than default characters (a-2)

< Back Next >

Einish

Cancel

Custom toolbar page

Create a toolbar for your Hildon project

Savebutton (Save)
mycombo (Combobox)

"add item

Clear All

= ™Y %

Enter name to your item: |Prefbutton

Select type: Button

Buttontype: Preferences
Avoid using other than default characters (a-z)

oK cancel

Avoid using other than default characters (a-2)

< Back Einish

ez

Cancel

Figure 5a,b. Wizard for customizing menu and toolbar

If user does not want to customize his empty project or create a new one, automake project
will let him to select a fully functioning Hildon application from few templates. These
templates are very handy, when you are taking a first look to the world of Hildon

applications.

Jautogen.sh is automatically run.

After creating a template user is ready to run clean/make, because

When Finish is clicked structure of project is created inside Scratchbox and ./autogen.sh is
run. Now user has a ready project and he can build it with Build or Clean, from Project

menu.

NOTE: Remember to check that all your settings are correct.

4.2.3 Standard Make C/C++ Project inside Scratchbox

In Standard Make C projects user can select a ready template or begin with empty project.
He will have to handle all makefiles himself and he is not able to create Debian packages
automatically. In C++ projects there are no ready templates.

Standard Make C project templates are simple GTK examples. They will help user to create
simple programs when he is familiarizing himself with GTK.
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& New Project

Add template to your project

I

Aviabl

Select one of the available templates to generate a fully-functioning Scratchbox
App.

reate your own Hildon template

¥ Use one of the ready templates

GTK Helloworld
This example helps you begin a
GTK Calendar programming GTK applications.
&TK Dial It will create a simple helloworld program.
Using GTK+ libraries and it will give you
GTK Tictactoe your first contact to the World of GTK
GTK FileTree Applications.

Remember to start your X server when
running or debugging your application.

r
< Back MNext > Finish Cancel

Figure 6. Wizard for selecting templates

4.3 Import existing automake project to Eclipse
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User can easily import non Eclipse projects by choosing menu option ”File->Import”.
After that pops up a normal import dialog (Figure 7.) and by selecting ”Existing Hildon
Automake C Projects inside Scratchbox” starts wizard for importing project to Eclipse.

3
3
3
3
3
3

b

DY

Ci-E @ w | X-1- @ |- 6 ¢
B C/C++ Projects 32 _Navigator

e R B
b Ehello
~ ESxterm

~ & Binaries

(aclocal
(=automate cache
(= debian

Eetc

(=icons

E=po

~ @src

[ terminal-app.h

[# terminal-gconf h

(8 terminal-settings.h

[5 terminal-tab-header h

(B terminal-widget h

81 main.c

[&l terminal-app.c

(€ terminal-settings.c

(&l terminal-tab-header.c
[&terminal-widget .
o0s50_xterm-main.o - [armle]
osso_xterm-terminal-app.o - [armle]
& osso_xterm-terminal-settings.o - [armle]

osso_xterm-terminal-tab-header.o - [armle:

[5ib os50_xterm-terminal-widget.o - [armle]
%5 osso-xterm - [armle]

& Makefile

(51 Makefile.am

[E Makefile.in

b [# config.h

AUTHORS
COPYING

[5 ChangeLog

INSTALL

5 Makefile

(5 Makefile .am

Makefile.in
Ixtermysrc/osso-xterm

Eile Edit Refactor MNavigate Search Project Run Window Help

SANCANE-SA0 DU R AL R R R

= B[ maine 2

& v /* $Id: main.c 4425 2005-09-16 08:09:49Z hedberg $ */

.
Al . ht (c) 2004 os-

. cific chang

.

* Written by Benedikt Meurer <benny@xfce.orgs.

B
Select \
V)

Create new Hildon Automake C project from a directory where is working automake [[==i]|
project.

Select an import source
[ Archive file
i Checkout Projects from Cvs

sting Hildon Autornake € Project inside Scratchbox

4 Existing Projects into Workspace
(@yExternal Features

“;External Plug-ins and Fragments
() File system

Elpreferences

@, Teamn Project Set

Back 7 Next > Einish cancel
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«
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SVN
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B outline 52 - ™1 =08

o
u
#
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°

= [Baers  »

B R e ¥
libintl.h

locale.h

stdlib.h

stdio.h
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terminal-app.h

main

Figure 7. Import existing project to Eclipse
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4.4

At first and second pages user has to set project name for imported project and adjust project
properties if needed. At the last page user must browse the import folder and when the finish
button is pressed, the project is created.

& Scratchbox import wizar x

Select import type:

Select a project type you wish to import

Available types: Copy the whole project to Scrachbox directory.
+ Full copy of your project You nged to have a wurkmg_autumake project.

This wizard only makes project and .cdtproject
files related to Eclipse, and leaves your project
untouched.
vou need to have a working autogen.sh. which
includes configure script in order to get support
for our menu features like 'Run autogen.sh'
If imported project does not include autogen.sh
file the default autogen.sh will be generated
autormatically.

fhomefmasa/maemo-packets/btkeyboard-plugin-0.2.2

< Back Finish Cancel

Figure 8. Browse the import folder

When creating a new project all files from import folder will be copied into a subfolder in
the Scrachbox directory. The imported folder needs to have a working automake
configuration. This wizard only makes .project and .cdtproject files related to Eclipse, and
leaves your project untouched. You need to have also a working autogen.sh, which includes
configure script in order to get support for our menu features like 'Run autogen.sh'. If
imported project does not include autogen.sh file the autogen.sh will be generated
automatically.

NOTE: Import existing project to Eclipse does not ensure that plugin could generate debian
package correctly.

Modifying project properties

The project properties can be accessed by either right-clicking on the project name in the
workspace navigator, or by choosing the menu option “Project->Properties” with the
corresponding project selected. Under the option “C/C++ Make Project Inside Scratchbox”
the user will be provided with tabs that offer modification of the properties for the builder,
and also enable choosing parsers for project binaries and builder error messages.
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. Properties for test

Info

Builders

C/C++ Docurmentation
C/C++ File Types
C/C++ Indexer

Project References

C/C++ Make Project Inside Scratchbox

Make builder settings.

ri| Error Parsers | Binary Parser

Build command

v Use default
Build cormnmand:
Build Setting
Stop on first build error.
Workbench Build Behavior
Warkbench build type: Make build target:
Build on resource save (Auto Build)

Note: see Workbench automatic build preference.

v Build (Incremental Build) all
v Rebuild (Full Build) clean all
v Clean clean

Build Directory

Build directory:

Restore Defaults

QK

Browse...

Apply

Cancel

Figure 9. Modifying the properties of a Scratchbox project

4.5 Compilation

16 (26)

v. 1.5

To compile a project, the standard “build” command can be used via the menus (“Project-
>Build Project”), or by the shortcut button. Then, the building commands that have been
issued are run and displayed on the console along with any output that the shell or Make

produce.

NOTE: that the Makefile for each Standard Make C/C++ Project inside Scratchbox needs to
be provided manually for the building to work.

In Automake Hildon Project inside Scratchbox user must only pay attention, when he is
adding or removing source files. Then he must run autogen.sh from “Project->Run
autogen.sh” in order to recreate makefile. After this you can build your project normally.
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config.status: executing depfiles commands &
1 FIs
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Figure 10. Compiling a project inside Scratchbox

4.6 Running

Here is an example how to run application: Once a binary is available, it may be run inside
Scratchbox using the standard “Run->Run...” menu option. There, the user has the option to
run it as a C/C++ Local Application (the CDT version, external to Scratchbox using the host
CPU) or as a C/C++ Scratchbox Application. By double-clicking on the “C/C++ Scratchbox
Application”, or choosing it and clicking “New”, will provide the user with configuration
options that allow setting the program file and its arguments. You can also access the Run...
dialog by selecting the binary.

Before running X-applications there is still one thing to do. If user wishes to X-emulate his
projects from Eclipse he needs to start X server. He will also need to start Maemo, if he has
done a Hildon application. X starts and stops easily from toolbar. Maemo starts from the
button next to X.

NOTE: Remember that you need to have X fully running before starting Maemo. Now you
are ready to run..

If run dialog tells, that user has not selected debugger, he should do it next. User can select it
from a debugger page. The server debugger works in port which has been set in ”Window-
> Preferences->Scratchbox Preferences”.

NOTE: If you have done a Hildon application you should run the program in standalone
mode. It can be selected from main tab.
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F-m 2

Create, manage, and run configurations

Configurations: Name: |myPackage
¢ C/C++ Local Application
~ ¢ CJC++ Scratchbox Applicati

4 Java Applet

@Ma\n (><I=Argumentsw EEnvlrunmant]?@-Debuggarl @Source] - Cemmen

= Project:
[T Java Application (=

Jujunit test Browse
3t Junit Plug-in Test C/C++ Application:
= @ Run-time Workbench
& Run-time Workbench

myPackage Search... Browse

¥ Connect process input & output to a terminal

¥ Run standalone. (Should be enabled when running Maemo applications)

New Delete Apply. Revert

Figure 11. Configuring a program for running it inside Scratchbox

4.6.1 Running when using SBRSH as CPU-transparency

4.7

First, the user has to have an existing target that uses SBRSH as CPU-transparency method.
More information about how this happens check these two links below:

http://www.scratchbox.org/download/files/sbox-releases/0.9.8/doc/installdoc.html#cputransp

http://maemo.org/platform/docs/howtos/howto cpu trans.html

After that user must select target and leave displays export field empty from Scratchbox
preference page. Now user can run programs normally and if everything succeeds, then the
program starts on the real (target) device and uses real devices CPU. This might take longer
than normally.

Debugging

The user may launch the debugger by choosing “Run->Debug”, and by creating a
configuration for the “Scratchbox C/C++ Scratchbox Application” similarly as when
running a program. On the “Debugger” tab, either “GDB Debugger inside Scratchbox” or
“GDB Server inside Scratchbox” should be entered as the debugger. To be able to debug
without the GDB Server, the program needs to be runnable on the host’s processor. On a
regular Linux PC this would in practice mean the debugging of an x86 program.
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4.7.1 GDB server inside Scratchbox

The GDB Server inside Scratchbox enables debugging on a target device. On debug dialog's
debugger tab user can choose GDB Server inside Scratchbox. He must also select connection
type: Serial or TCP.

If Serial is selected user has to select Device and Speed for the serial connection. Speed for
N770 serial connection is 115200.

When debugging over TCP inside Scratchbox user must first setup Scratchbox preferences,
(see 4.1) set IP and Port from debugging tab and enable Start GDB-Server Automatically.

NOTE: Using QEMU-ARM debugger on localhost you must set hostname to localhost and
always use port 1234. (see known issues 6.4)

Create, manage, and run configurations g
@ [Main]: Project not specified p
Configurations: Name: |New7cunf|guratmn (2)
[Elc/C++ Attach to Local A
C/C++ Ly | Applicat = =
Eles ccal Application £ Main | 69-Arguments | BEEnvironmen t| 3=Debugger | & Source =iCommon
[Elc/C++ Postmortern deb
~ ¢ C/C++ Scratchbox Appli Debugger: “GDE Server inside Scratchbox -~
¢
b @ Eclipse Application [X] stop at main() on startup =~ Advance d...
Eiljava Applet Debugger Options
b Ojava Application
) PP | Main | Shared Libraries
JujUnit
Jijunit Plug-in Test GDE debugger |gdb Browse...
Z, Remote Java Application
—_— GDB command file: | Browse...
= swT Application
[} start GDB-Server Automatically. (See Scratchbox Preferences)
Connec tion: |Serial -

Device: |/dev/ttySo
Speed: 115200 @«

o 3

New Delete Apply. Revert

Close

Figure 12. Choosing the debugger for debugging inside Scratchbox

4.7.2 GDB server in real device

The GDB Server enables debugging on a real device. If user wants to debug in real device
he must install GDB server on that device. Also he must know device's IP address if he
debugs over TCP. On debug dialog's debugger tab he can choose GDB Server inside
Scratchbox and select connection. GDB Server must be started (run-standalone.sh) every
time manually from real device before debugging. Start GDB Server Automatically should
not be enabled when debugging in the real device.

4.7.3 Debugging when using SBRSH as CPU-transparency

First user must select target that uses SBRSH as CPU-transparency method. See more
information from chapter 4.5.1. Also device's IP address must be known when debugging


http://www.cs.tut.fi/~laika/

TUT/NOKIA LAIKA USER GUIDE 20 (26)

Laika project: 26.10.2005 v. 1.5
http://www.cs.tut.fi/~laika/

over TCP. User has to set GDB server field from Scratchbox preference page. When using
SBRSH syntax could be example “gdbserver localhost:10000 ${binary}”. From X-
environment preference page field exporting displays IP and number should be empty. After
that when user have set all preferences everything should be OK to debug programs. On
debug dialog's debugger tab user can choose GDB Server inside Scratchbox and select
connection (TCP). Target device's IP (e.g. 192.168.2.15 when using N770 USB-net) and port
(e.g. 10000) should be selected. Also Start GDB server automatically should be turned on.
Now user is ready to debug programs.

4.8 Making Debian package

User can create Debian packages for N770 Application Installer. This function provides an
easy way to import user made applications to N770.

4.8.1 Make rules for project's Debian package

This item opens dialog where user can insert the name of the package, description, version,
index numbers for the application and the subfolder of Debian package. The user must also
select an entry page for makefile. This means that makefile finds other related files in
current project. Index number controls the order of the list of applications in the
extra_applications menu. If create new folder is selected then user must also assign the name
and index number of the subfolder.

After the dialog is filled and ok button is pressed the rules for creating Debian package are
created into debian/ -folder.

Index number: 0000

Package name: application

Package description: Enter here your description
ersion: for this Debian package

1 v |0 =

Select an entrypage for makefile:  |fsre/main.c -
¥ Create new folder? Help
Select & folder number in N770 0000
Enter an install folder name in N770 |subfolder
Create a dpkg package:
oK Cancel

Figure 13. Making rules for Debian package

4.8.2 Make Debian package

”Make Debian package” runs make deb command and tries to create an installable Debian
package according to the rules on /debian folder.
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Figure 4. Items for making Debian package

4.9 Installing Debian package to real device
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There are lots of different methods to install Debian package to Nokia 770. The package
must be first transferred to N770 (or mem card). Transferring methods are WLAN, Internet
connection through mobile phone, bluetooth, memory card and USB (adv users). After
transferring the Debian package to N770 (or mem card) the package can be installed from
control panel. Start Application installer and locate the package by browsing the files. The
Application installer recognizes the package and it can be installed. The installer tells if the
package was completely installed.

NOTE: Installing debian package created with dpkg option requires super user privilidges.

4.10 Toolbar buttons

4.10.1 X-Windowing

4.10.1.1 Start X

Start X button starts the X server and viewer. The start commands are defined in Setting
preferences chapter 4.1. If the X server includes the viewer then only one command is
needed in preferences page. Ultimately if X server does not start when the button is pressed
the preferences should be checked. Some X programs need to be run inside Scratchbox, so
the checkbox should be enabled if using such software.
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4.10.1.2 Stop X

Stop X is implemented with rough method. The X server is killed with killall command.

4.10.2 Maemo

Handling Maemo is done by running scripts inside Scratchbox target. The commands used
for starting, restartin and stopping Maemo are: af-sb init (start/restart/stop).

4.10.3 Scratchbox

4.10.3.1 Adding own templates

User can customize his plugin by adding new templates to New Project Wizard. This makes
it possible to add for example basic architechtural structure of project in every project the
user / company creates. The template installer can be started from Scratchbox toolbar menu.
The user is asked to tell the directory he wants to copy inside plugin, so the new template
will be always found from plugin. Pay special attention when selecting folder you are
adding. The installer will warn every time the template is about to be added, but serious
trouble will follow when for example / (root) folder is selected.

4.10.3.2 Running commands inside Scratchbox

If some special commands are not supported by our plugin, there is no need to start terminal
necessarily. You can run console command form Scratchbox toolbar icon. The output is
written to eclipse console. The command is runned in the folder the user has selected. The
default folder is users home directory in Scratchbox.
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5 BEHIND THE SCENES

5.1

5.2

5.3

Automake

Automake is a tool that helps building the application and relieves the user from the task of
creating a makefile. In this version of the plugin the automake is quite stupid and requires
some definitions to be in the same files. Automake requires (in order to maintain
compability with debian package creation) that the main file (should be the file that makes
the actual osso_initialization) contains at least definitions APP_NAME and APP_VER to
register the application to DBUS. Others needed in the main file APP_SERVICE and
APP_METHOD, they are needed in setting up the rpc callback. When a automake project is
created the default files are read and reconfigured properly to create working files to enable
automaking feature.

Other things needed in our automake are the properly configured Makefile.am and
configure.ac. The configure.ac must contain variables PACKAGE=<application_name> and
VERSION=<application_version> and the correct paths for .desktop and .service files.
Libraries can be modified quite freely, at this stage default includes are all Hildon libraries
and GTK. Makefile.am requires that when the BIN_PROGRAM, _SOURCES or _LDADD is
defined the definition must begin with eg. # Binary and end with # /Binary. When the
package name is changed (eg. renaming in the debian packaging rules) the Makefile.am is
patched using the commentlines and the package name will be changed in the correct places.

Running autogen.sh through menus patches the sources (_SOURCES) of the root
Makefile.am or src/Makefile.am to include all .c -files in the src¢/ -folder and subfolders. So
C++ isn't working very well, yet.

Generating debian packaging rules

Generating debian package modifies the Makefile.am, configure.ac and the main() -file like
discussed in the previous chapter (5.1). It also creates a new files to debian/ -folder. These
files control how the debian package is built, version numbers and such. One of the files is
the <application_name>.links file that controls where the symbolic link is created in the
install process. Depending on the installation style (application installer vs. dpkg -i (as root)
from the console) and the installation subfolder the file looks different.

Re-running the package creation rules should NOT break the files, but since it based on just
a stupid find&replace -method, it is possible (however unlikely) that some files may break!

Building the debian package

The command for building the debian package can (and must) in the Makefile in the root
section of the application. The makefile must contain rules to run make deb, since the plugin
builds the package via the makefile. The rule for make deb can simply be the dpkg-
buildpackage -rfakeroot, that is covered in the tutorial pages of maemo [Maemo].
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6 KNOWN ISSUES

6.1

6.2

6.3

This is an open source project, so we hope help also from all the users of Laika. We kindly
ask you to report found bugs to our developers laika@cs.tut.fi.

The latest bug reports are found in:

http://kooditakomo.cs.tut.fi/projects/laika/

(http://www.cs.tut.fi/~laika/bugs.shtml)

General

The “login” script that is used to run commands will output an error in the end of each
command that is run, because it attempts to kill a process that is already dead. If this
disturbs the user, the last two lines of the script /scratchbox/login may be commented out.
Their effect is to attempt to kill the process group of the script.

This plugin is tested only on GNU/Linux Debian distribution.

You may face problems when versions differ from our supported versions. (see
requirements 2)

Eclipse

When selecting the error parsers in project creation, the settings will actually only take
effect for the next project created. They may be set for a project via the project property
settings (see Section 4.3). This is a bug (or a feature) in CDT, not in the Scratchbox
Development Tools.

X-server is killed from toolbar with killall command.

In "Standard Make C Project inside Scratchbox" and "Automake Hildon Project inside
Scratchbox", when you choose a template and click "Next" nothing happens. Clicking
”Finish" the project is created.

"Build Automatically" should be enabled from ”Project->Build automatically”. When
creating new project Eclipse try build project before autogen.sh hasn't yet created
makefile. So you could disable "Build Automatically" from project menu or clean project.

Maemo

Hildon applications must be run in standalone mode.

Osso initialization will fail when using SBRSH as CPU-transparency method
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6.4 Debugging

® Using GDB server inside Scratchbox with QEMU-ARM emulation fails to connect GDB
server sometimes when using Maemo 1.0 rootstrap. After successful launch of QEMU-
ARM server, the server will mostly work fine. If you receive an error message, try again.
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